ElectricAccelerator® Visual Studio Integration version 5.2.5

Copyright © 2002–2018 Electric Cloud, Inc. All rights reserved.

Published 6/12/2018

Electric Cloud® believes the information in this publication is accurate as of its publication date. The information is subject to change without notice and does not represent a commitment from the vendor.

THE INFORMATION IN THIS PUBLICATION IS PROVIDED “AS IS.” ELECTRIC CLOUD, INCORPORATED MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND WITH RESPECT TO THE INFORMATION IN THIS PUBLICATION, AND SPECIFICALLY DISCLAIMS IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

Use, copying, and distribution of any ELECTRIC CLOUD software described in this publication requires an applicable software license.

Copyright protection includes all forms and matters of copyrightable material and information now allowed by statutory or judicial law or hereinafter granted, including without limitation, material generated from software programs displayed on the screen such as icons, screen display appearance, and so on.

The software and/or databases described in this document are furnished under a license agreement or nondisclosure agreement. The software and/or databases may be used or copied only in accordance with terms of the agreement. It is against the law to copy the software on any medium except as specifically allowed in the license or nondisclosure agreement.

Trademarks

Electric Cloud, ElectricAccelerator, ElectricAccelerator Huddle, ElectricCommander, ElectricDeploy, ElectricInsight, and Electric Make are registered trademarks or trademarks of Electric Cloud, Incorporated.


Other product names mentioned in this guide might be trademarks or registered trademarks of their respective owners and are hereby acknowledged.
Contents

Chapter 1: Overview ................................................................. 1-1
  About the ElectricAccelerator® Visual Studio Integration ......................... 1-1

Chapter 2: What’s New .............................................................. 2-1
  New Features and Functionality in Version 5.2.5 .................................. 2-1
  Resolved Issues in Version 5.2.5 .................................................. 2-1
  Resolved Issues in Version 5.2.4 .................................................. 2-1
  New Features and Functionality in Version 5.2.3 .................................. 2-1
  Resolved Issues in Version 5.2.3 .................................................. 2-2
  New Features and Functionality in Version 5.2.2 .................................. 2-2
  Resolved Issues in Version 5.2.2 .................................................. 2-2
  New Features and Functionality in Version 5.2.1 .................................. 2-2
  Resolved Issues in Version 5.2.1 .................................................. 2-3
  New Features and Functionality in Version 5.2 .................................... 2-3
  Resolved Issues in Version 5.2 .................................................... 2-3

Chapter 3: Known Issues ............................................................ 3-1

Chapter 4: System Requirements .................................................. 4-1
  Supported Visual Studio Versions .................................................. 4-1
  Prerequisites ............................................................................. 4-1
    MSBuild Prerequisites ............................................................. 4-1
    VS IDE Extension Prerequisites .................................................. 4-2
    VS Converter Extension Prerequisites .......................................... 4-2
    ecdevenv Utility Prerequisites ................................................... 4-2
    Upgrade Notes ........................................................................ 4-2

Chapter 5: Installing the IDE Integration ........................................... 5-1
  Installing the Integration Using the GUI .......................................... 5-1
  Installing the Integration Silently ................................................... 5-1

Chapter 6: Using the VS IDE Extension Interface .................................. 6-1
  Main Menu and Toolbar .................................................................. 6-2
  Build Solution Locally .................................................................... 6-3
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Pane</td>
<td>6-4</td>
</tr>
<tr>
<td>Context-Sensitive Menus</td>
<td>6-5</td>
</tr>
<tr>
<td>Solution Settings</td>
<td>6-8</td>
</tr>
<tr>
<td>General Solution Settings</td>
<td>6-8</td>
</tr>
<tr>
<td>ElectricInsight Solution Settings</td>
<td>6-14</td>
</tr>
<tr>
<td>Options Solution Settings</td>
<td>6-16</td>
</tr>
<tr>
<td>Debug Solution Settings</td>
<td>6-18</td>
</tr>
<tr>
<td>Advanced Solution Settings</td>
<td>6-21</td>
</tr>
<tr>
<td>Command Line Solution Settings</td>
<td>6-23</td>
</tr>
<tr>
<td>Help Menu</td>
<td>6-24</td>
</tr>
<tr>
<td>About</td>
<td>6-25</td>
</tr>
</tbody>
</table>

Chapter 7: Using the ecdevenv Utility ........................................... 7-1

- About ecdevenv .................................................................................. 7-1
  - No Makefiles are Required ................................................................ 7-1
  - Miscellaneous Files that ecdevenv Generates .................................. 7-1
- Virtualizing the Visual Studio Toolchain ....................................... 7-2
- Building Multiple Solutions and Projects ........................................ 7-2
- Enabling Debugging Output .................................................................. 7-3
- Using ecdevenv Command Options ..................................................... 7-3
- Using ecdevenv Environmental Variables .......................................... 7-4
- Using Fast Solution Conversion ....................................................... 7-5
- Supporting Multi-Byte Characters ..................................................... 7-6

Chapter 8: Building VS from the Command Line ...................................... 8-1

- Using ecdevenv ..................................................................................... 8-1
- Creating a Makefile ............................................................................. 8-1
- Setting the Path for 64-Bit or Xbox Builds ...................................... 8-2

Chapter 9: Setting VS Converter Environment Variables ........................ 9-1

- Setting the Converter Variables ....................................................... 9-1
- Relocating Makefiles Generated by the Converter ............................... 9-10
- Setting the Environment Variable to Enable Local Solution Builds ....... 9-11
- Setting the Environment Variable for ecdevenv Startup Checks ............ 9-11

Chapter 10: Tuning Performance ............................................................ 10-1

- Improving Build Time for /Zi + PCH Builds ...................................... 10-1
- Improving Build Time for Solutions with Many Projects ....................... 10-1
- Improving Final Link Time ................................................................... 10-2
- Improving Incremental Build Time ..................................................... 10-2
Improving Incremental Linking Time ................................................................. 10-2
Improving Incremental Linking Time with the Converter .................................... 10-2
Improving Incremental Linking Time without the Converter .................................. 10-2
Optimizing Parallelization Using PDB Splitting ..................................................... 10-3
Optimizing Parallelization with the Converter ....................................................... 10-3
Optimizing Parallelization without the Converter .................................................. 10-3
Troubleshooting ...................................................................................................... 10-4

Chapter 11: Using MSBuild ..................................................................................... 11-1
Building MSBuild Projects in Parallel ................................................................. 11-1
Using MSBuild to Build a Project Directly in Its Solution Context ....................... 11-1

Chapter 12: Uninstalling the Visual Studio Integration ............................................ 12-1
Uninstalling the Visual Studio Integration on Windows ........................................ 12-1
Using the GUI ......................................................................................................... 12-1
Using the Command Line ....................................................................................... 12-2

Chapter 13: Debugging a Failed Build .................................................................... 13-1

Chapter 14: Troubleshooting Problems ................................................................ 14-1
Initializing Visual Studio ........................................................................................ 14-1
Common Issues ....................................................................................................... 14-1
Visual Studio is missing the Electric Cloud menu .................................................. 14-2
Application Data folder could not be created. make: *** [all] ................................. 14-2
For VS2005 SP1 builds, the build is not broken up and runs as one large job .......... 14-3
Build terminated with “not making progress” error ................................................. 14-3
Visual Studio quits immediately at the start of the build ...................................... 14-3
Error “‘devenv’ not found” is displayed .................................................................... 14-3
Error “Unable to build specified project” or missing file errors ............................... 14-3
Error “msbuild not found” ..................................................................................... 14-4
Missing DLL errors or Visual Studio installation is corrupt ................................ 14-4
Error “command line too long” .............................................................................. 14-4
The build is slow (not parallelized) and/or each line of the build output is prefixed with 1>,
2>, etc ...................................................................................................................... 14-4
Error: ‘|’ not recognized ......................................................................................... 14-4
When virtualizing the Visual Studio toolchain, regsvr32 fails trying to register a DLL that
uses debug CRT DLLs ......................................................................................... 14-5
Particular projects do not build under eMake ........................................................ 14-5
Electric Cloud menu in Visual Studio is grayed out (disabled) ............................... 14-5
Using Visual Studio 2010, a project fails at link when using the add-in but succeeds when using Visual Studio alone .................................................................14-5
Upgrading only cluster agents to Accelerator v7.0 might cause an error ....................... 14-6

Index ........................................................................................................................................15-1
Chapter 1: Overview

About the ElectricAccelerator® Visual Studio Integration

The ElectricAccelerator Visual Studio Integration is composed of two distinct converters and the ecdevenv.exe utility:

- **Visual Studio IDE Extension**
  This extension integrates with the Microsoft Visual Studio IDE and lets you build Visual Studio solutions and projects using Electric Make® (eMake) from within the IDE. The extension provides an Electric Cloud build menu and toolbar. The existing build menu remains intact for local (non-eMake) builds.
  
  This was implemented as a VSPackage starting with Visual Studio 2015 and as an add-in in earlier versions of Visual Studio.

- **Visual Studio Converter Extension**
  This extension converts solutions and projects into NMAKE makefiles for eMake compatibility. It is invoked for command-line builds and ecdevenv.exe.
  
  This was implemented as a VSPackage starting with Visual Studio 2015 and as an add-in in earlier versions of Visual Studio.

- **ecdevenv.exe Utility**
  ecdevenv is a drop-in replacement for devenv.exe that builds Visual Studio solutions and projects using eMake. It provides a number of important features. See Using the ecdevenv Utility on page 7-1 for information. ecdevenv.exe is invoked by the Visual Studio IDE extension to perform eMake builds.

The ElectricAccelerator Visual Studio Integration is installed automatically during the installation of ElectricAccelerator.
Chapter 2: What's New

New Features and Functionality in Version 5.2.5

The installers for the Visual Studio Extension 5.2.5 and for ElectricAccelerator 10.1 are enhanced to let you automatically initialize Visual Studio on agent hosts:

- In the Visual Studio Extension installer, the Initialize Visual Studio for ECloudInternalUsers checkbox is added to the Select Visual Studio Version screen. (VSP-1167)
- In the ElectricAccelerator installer, the Initialize Visual Studio for ECloudInternalUsers checkbox is added to the Configuring the Electric Agent screen. (EC-12802)

Note: Using this checkbox can add up to 30 minutes to installation times (depending on the number of agents and the number of installed Visual Studio versions).

Resolved Issues in Version 5.2.5

Visual Studio Converter Extension

- An issue is fixed in which MSBuild did not create certain required directories (such as for logging) if the build used build customizations. This issue caused the following error message: error MSB3491: Could not write lines to file \<file>. (VSP-1159)

Installer

- Because of a known issue, the ability to upgrade the Visual Studio Integration on all Windows agent hosts that are registered to the Cluster Manager that you specify is removed. This means that the installer now performs only local installations, and therefore, the Setup Type dialog box is removed. (VSP-1166)

Resolved Issues in Version 5.2.4

Visual Studio IDE Extension

- The Max Local Agents field in the Advanced tab of the Solution Settings window is now disabled (regardless of whether it was previously set) if the installed eMake version is 9.1 or later. (VSP-1134)

Visual Studio Converter Extension

- Using the /FU compiler option no longer produces duplicate assemblies. (VSP-1151)
- The issue where environment variables in response files were not expanded is fixed. (VSP-1133)

New Features and Functionality in Version 5.2.3

Visual Studio Converter Extension
To improve MSBuild build times for unparsable projects (such as those containing Build Customizations), the extension now passes the MSBuild /m switch (without a value) to MSBuild so that all cores are used by default. (VSP-1132)

Resolved Issues in Version 5.2.3

Visual Studio IDE Extension

- The setting for the MSBuild project build output verbosity level is now passed to add-in based builds so that they show the same level of verbosity as Visual Studio. (VSP-1131)

- For Accelerator 9.1 and later versions, you can no longer simultaneously use local agents and a cluster manager. This means that the Use Local Agents check box in the General > Cluster tab of the Solution Settings window has no effect when you specify a cluster manager using the Cluster Manager field in the General > Basic tab. This also means that simultaneously using the --emake-localagents eMake option and the --emake-cm eMake option from the command line produces an error. (VSP-1130)

Visual Studio Converter Extension

- The extension now turns off parsing for projects with more-complex Build Customizations and instead uses MSBuild. This avoids the fatal error C1083: Cannot open include file: '<filename>.h': No such file or directory error because eMake could not locate the header file. (VSP-1129)

New Features and Functionality in Version 5.2.2

Visual Studio Converter Extension

- (Visual Studio 2010 and newer versions) The ECADDIN_USE_MSBUILD_FOR_LINK environment variable and the UseMSBuildForLink configuration file variable are introduced. When these variables are enabled, the extension uses MSBuild for linking. These variables are a workaround for an issue in which VCManifestTool is not supported in Visual Studio 2015 and newer versions and might not be supported in Visual Studio 2010–2013.

  These variables are enabled by default for Visual Studio 2015 and newer versions and disabled by default for Visual Studio 2010–2013. (VSP-1118)

Resolved Issues in Version 5.2.2

Visual Studio IDE Extension

- The issue where the Electric Cloud > Debug Project menu option is unresponsive on some Visual Studio versions is fixed. (VSP-1124)

Visual Studio Converter Extension

- The following NMAKE error no longer occurs when you import more than one library and up-to-date-check is enabled: fatal error U1000: syntax error: ')’ missing in macro invocation. (VSP-1122)

New Features and Functionality in Version 5.2.1

Visual Studio 2017 Community and Enterprise Edition Support
ElectricAccelerator Visual Studio Extension 5.2.5

Support is added for the Community and Enterprise editions of Visual Studio 2017. The integration is installed for all editions. (VSP-1110)

Visual Studio Converter Extension

Support is added for Visual Studio build customizations. If you encounter issues with a project when using this feature, you can disable it for all projects containing Build Customizations by setting ECADDIN_PARSE_BUILD_CUSTOMIZATIONS or ParseBuildCustomizations to FALSE or by disabling parsing for only that project by setting ECADDIN_DONT_PARSE_PROJECT or DoNotParseSpecificProjects to TRUE. (VSP-1071)

Resolved Issues in Version 5.2.1

Visual Studio Converter Extension

- Fixed an NMAKE: fatal error U1073: don't know how to make '"<file>"' error that occurred when a project contained a source file whose path used a macro. (VSP-1121)
- The LINK: fatal error LNK1146: no argument specified with option '/'MANIFESTFILE:' error no longer appears. (VSP-1116)
- The converter extension no longer assumes a Visual Studio DPI Awareness setting of None. All Visual Studio DPI Awareness settings are now recognized. (VSP-760)

New Features and Functionality in Version 5.2

Visual Studio Converter Extension

- Support is added for Visual Studio Professional 2017. For details, see https://docs.microsoft.com/en-us/cpp/what-s-new-for-visual-cpp-in-visual-studio. Note that the /PERMISSIVE switch is not supported in the Visual Studio IDE. (VSP-1109 and VSP-1090)
- Support for Visual Studio 2005 is reintroduced. (VSP-1106)
- The ECADDIN_LINK_PARAMETERS environment variable and the LinkParameters configuration file variable are introduced. These variables add options to the linker command. For example, ECADDIN_LINK_PARAMETERS=/OPT:REF or LinkParameters=/INCREMENTAL /NOLOGO /DEBUG /PDB:a.pdb. (VSP-1102)
- The ECADDIN_NORECURSE environment variable and the NoRecurse configuration file variable are introduced. When these variables are enabled, only the specified project configurations are built, and dependent projects in those configurations are ignored. (VSP-1101)
- The ECADDIN_NOLINK environment variable and the NoLink configuration file variable are introduced. When these variables are enabled, all build steps are performed except linking and post-build steps. (VSP-1100)

Resolved Issues in Version 5.2

Visual Studio Converter Extension

- A clean dependency is added for rebuilds (not builds) to improve build speed. (VSP-1096)

ecdevenv Utility
The issue where selective project regeneration failed because ecdenv did not use the correct project name when the projects had relative paths is fixed. (VSP-1103)
Chapter 3: Known Issues

- If up-to-date check is enabled, custom build steps do not rebuild if the output is missing.
- Order-only prerequisites are turned off automatically when up-to-date check is enabled.
- If the cluster upgrade option of the VS IDE Converter installer fails, re-run the installer to ensure the VS Converter is installed correctly.
- Because of an issue with previous versions’ uninstallers, an upgrade might cause the following error message: Cannot find script file: C:\ECloud\i686_win32\bin\unregaddin.vbs. You can ignore this message.
- Make sure you finish all Visual Studio installations before installing the VS IDE Integration. Adding a new language to an existing Visual Studio installation with the VS IDE Integration already installed causes Visual Studio to display an empty Electric Cloud menu. The workaround is to reinstall the integration.
- Visual Studio 2008 builds might break or might not be optimized after you upgrade from an earlier version. For instructions to work around this issue, see the knowledge base article KBEA-00065, The build breaks after upgrading to Visual Studio 2008.
- In Microsoft Visual C++ 2010 and later, projects that contain custom build rules are not parallelized at the project item level.
- LightSwitch projects are not supported.
- UWP projects are not supported.
- For Visual Studio 2010 and later, the MSBuild item metadata syntax is not supported for C++ build events (pre-build, pre-link, and post-build events). The workaround is to substitute the variables with actual values or use ECADDIN_DONT_PARSE_PROJECT to build the project with MSBuild.
Chapter 4: System Requirements

Supported Visual Studio Versions

The Visual Studio IDE Integration supports the following versions of Visual Studio:

- Visual Studio 2017 (all editions)
- Visual Studio 2015
- Visual Studio 2013
- Visual Studio 2012
- Visual Studio 2010
- Visual Studio 2008
- Visual Studio 2005

Note: The VS IDE Converter for Visual Studio 2010 or later does not support Xbox builds, Windows Mobile configurations, or custom build rules.

Prerequisites

MSBuild Prerequisites

The IDE converter cannot virtualize the MSBuild utility. If you are virtualizing your toolchain, you might need to install the following packages for your version of Visual Studio on every agent host in your cluster.

<table>
<thead>
<tr>
<th>Visual Studio Version</th>
<th>Packages</th>
</tr>
</thead>
<tbody>
<tr>
<td>2017</td>
<td>.NET Framework 4.6.2</td>
</tr>
<tr>
<td></td>
<td>MSBuild Tools 15.0</td>
</tr>
<tr>
<td></td>
<td>Visual C++ Build Tools 15.0</td>
</tr>
<tr>
<td>2015</td>
<td>.NET Framework 4.6</td>
</tr>
<tr>
<td></td>
<td>Microsoft Build Tools 2015</td>
</tr>
<tr>
<td>2013</td>
<td>.NET Framework 4.5</td>
</tr>
<tr>
<td></td>
<td>Microsoft Build Tools 2013</td>
</tr>
<tr>
<td>2012</td>
<td>.NET Framework 4.0.30319</td>
</tr>
<tr>
<td>2010</td>
<td>.NET Framework 4.0.30319</td>
</tr>
<tr>
<td>2008</td>
<td>.NET Framework 3.5</td>
</tr>
</tbody>
</table>
If you do not virtualize your toolchain, you must install Visual Studio on each agent host in your cluster.

**VS IDE Extension Prerequisites**

The VS IDE Extension requires:

- eMake installed on the build machine
- .NET Framework v2.0

**VS Converter Extension Prerequisites**

The VS Converter Extension requires:

- Microsoft Visual C++ 2010 Redistributable Package
- .NET Framework v2.0
- (If using Visual Studio 2005 Service Pack 1) Microsoft hotfix that is described in Microsoft Knowledge Base articles 933054 and 934517. Without the hotfix, the VS Converter Add-In will not function correctly, which means that ecdevenv is not called, so builds will not be accelerated.


**ecdevenv Utility Prerequisites**

The ecdevenv utility requires:

- VS Converter Extension
- Microsoft Visual C++ 2005 SP1 Redistributable Package
- .NET Framework v2.0

**Upgrade Notes**

Electric Cloud recommends regenerating the history file after upgrading the VS Integration.
Chapter 5: Installing the IDE Integration

Installing the Integration Using the GUI

To install the VS IDE integration using the installation wizard:

1. Right-click the VSIntegration-<version>-Install.exe file and choose Run as administrator.
2. When the ElectricAccelerator VS Integration Setup screen appears, click Next.
3. When the Choose Destination Location screen appears, click Next to accept the default installation location (C:\ECloud) or click Browse to change the location and then click Next.
4. When the Select Visual Studio Version screen appears, make the following selections and then click Next:
   - **Installed versions**—Choose specific Visual Studio versions where you want the converter to be installed.
     By default, all the Visual Studio versions are selected.
   - **Initialize Visual Studio for ECloudInternalUsers**—If you do not virtualize the toolchain, you must use this option, which initializes Visual Studio on every agent host for each ECloudInternalUser.
     Each Accelerator agent runs as user ECloudInternalUser1, ECloudInternalUser2, and so on.
5. When the Installing screen appears, you can view the progress of the installation.
6. When the ElectricAccelerator VS Integration Setup screen displays ElectricAccelerator VS Integration Wizard Complete, your installation is complete. Click Finish to close the installer.

The installation log file is in the installation directory’s root, C:\ECloud by default.

Installing the Integration Silently

To perform a silent installation, follow these steps:

1. For the first installation, run the installation with the /save-response-file <filename> option and your desired settings.
   This creates the response file in the directory where you ran the installer.
2. For subsequent silent identical installations, use the resulting response file by using the /response-file <filename> and /mode silent options.

The syntax for silent installation is:

VSIntegration-<version>-Install.exe [options]
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/mode &lt;install_mode&gt;</td>
<td>Installation mode. Available values are standard (default) or silent.</td>
</tr>
<tr>
<td>/prefix &lt;directory&gt;</td>
<td>Installation directory.</td>
</tr>
<tr>
<td>/response-file &lt;response_input_file&gt;</td>
<td>File from which to read installer responses.</td>
</tr>
<tr>
<td>/save-response-file &lt;response_output_file&gt;</td>
<td>File to which installer responses are written when the installer exits.</td>
</tr>
<tr>
<td>/temp &lt;temp_dir&gt;</td>
<td>Temporary directory used by the installer.</td>
</tr>
<tr>
<td>/version</td>
<td>Displays installer version information.</td>
</tr>
<tr>
<td>/vsinit &lt;0</td>
<td>1&gt;</td>
</tr>
</tbody>
</table>
Chapter 6: Using the VS IDE Extension Interface

When the VS IDE Extension starts, it checks if the following are present:

- **eMake**— If the converter cannot find eMake, the converter's Build, Rebuild, and Clean functions are disabled.

  When eMake is run from Visual Studio, it must be run through an intermediate application named `ecspawn.exe`. This program ensures that eMake responds correctly to Ctrl-C and that child processes are grouped together. This application is displayed in the Task Manager. Do not terminate the application; it stops when the build finishes or when the build is canceled.

  Do not run local (non-eMake) builds while running eMake builds and vice-versa.

- **ElectricInsight®**—If the converter cannot find Insight, the converter's Run ElectricInsight function is disabled.

**Topics:**

- [Main Menu and Toolbar on page 6-2](#)
- [Solution Settings on page 6-8](#)
Main Menu and Toolbar

When you run Visual Studio, you are presented with the Electric Cloud main menu and toolbar:

The menu has the following functions:

- **Build Solution**—Builds the current solution
- **Build Solution Locally**—Builds the current solution locally with eMake but *without using* remote agents or local agents (this function is equivalent to turning off the Cluster Manager and local agents). This function is hidden by default. See **Build Solution Locally** on page 6-3 for additional information about this function.
- **Rebuild Solution**—Rebuilds the current solution
- **Clean Solution**—Cleans the current solution
- **Build** `<project>`—Builds the current project or selection
- **Rebuild** `<project>`—Rebuilds the current project or selection
- **Clean** `<project>`—Cleans the project or selection
- **Cancel**—Cancels a running eMake build. When a build is running, you can cancel it by selecting **Cancel**. **Cancel** is available only during a running build, rebuild, or clean.
- **Run ElectricInsight**—Runs Insight with the current annotation file (if it exists). At any time, you might run ElectricInsight (Insight) to view the annotation file. Insight loads the specified annotation file or defaults to emake.xml.

  When you run Insight from Visual Studio, Visual Studio looks for the currently running instance of einsight. If einsight is currently running, the annotation file is not loaded (or reloaded). Manually open the annotation file from Insight, or close Insight and select **Run ElectricInsight** again.

  On 64-bit systems, this menu option invokes the 64-bit version of ElectricInsight. For details about the 64-bit and 32-bit versions of ElectricInsight, see the “Installing ElectricInsight” chapter in the *ElectricInsight User Guide* at http://docs.electric-cloud.com/accelerator_doc/AcceleratorIndex.html.

- **Settings**—Opens the solution settings dialog box

- **Help** submenu
  - **Help**—Display help resources
  - **About**—Displays information about the current extension installed

When selecting one of the build commands, the converter calls ecdevenv.exe to perform the build.

The project and configuration are taken from the current context. The command is dependent on the menu item.

The toolbar provides the same functionality as the Electric Cloud main menu and is customizable.

---

**Build Solution Locally**

You can build a solution locally with eMake but *without using* remote agents or local agents. You might want to use this function if a distributed incremental build is slow, or if a local Visual Studio incremental build causes unnecessary rebuilding of objects. To make this function visible in the menu, set the environment variable `ECUIADDIN_LOCAL_BUILD=true`.

The following screenshot illustrates the menu with the **Build Solution Locally** function.
Advisories for Build Solution Locally

- The eMake local build does **not** support the eMake eDepend feature (also called Auto Depend). This means changes in header files might not cause dependent source files to be recompiled.
- The eMake local build does **not** produce an annotation.
- Because history is not generated, unexpected conflicts might occur on subsequent eMake cluster builds.

Output Pane

Output from an eMake build is displayed in the **EC Build** output pane (displayed in the following screenshot).
Context-Sensitive Menus

The converter provides additional context-sensitive menus. The following screenshot illustrates the Solution menu.
The following screenshot illustrates the **Project** menu.
The following screenshot illustrates the **Selection** menu.
Solution Settings

The Solution settings dialog box contains the following Solution Settings categories:

- General Solution Settings on page 6-8
- ElectricInsight Solution Settings on page 6-14
- Options Solution Settings on page 6-16
- Debug Solution Settings on page 6-18
- Advanced Solution Settings on page 6-21
- Command Line Solution Settings on page 6-23

Note: See Setting VS Converter Environment Variables on page 9-1 for environment variable descriptions.

General Solution Settings

This category contains most frequently used settings:

- Basic Solution Settings on page 6-8
- Cluster Solution Settings on page 6-10
- History Solution Settings on page 6-10
- Performance Solution Settings on page 6-11
- Annotation Solution Settings on page 6-13

Basic Solution Settings

The following screenshot illustrates the Basic subcategory.
- **Cluster Manager**—Indicates the eMake Cluster Manager (`--emake-cm`).
  
  If this field is empty, an eMake build is performed with local agents when **Use Local Agents** is selected. When **Use Local Agents** is not selected, a local eMake build (without remote or local agents) is performed.

  For Accelerator 9.1 and later versions, you cannot simultaneously use local agents and a cluster manager. If you specify a cluster manager in this field, the setting for the **Use Local Agents** checkbox is ignored.

- **Root**—Specifies the eMake root (`--emake-root`). To add a path to the eMake root manually, enter a path or click the folder button to browse and then click the plus button to add it to the list. To delete a path from the eMake root manually, select it in the list and click the x button.

- **Add Emake Roots Automatically**—Adds the locations of all inputs (such as .cpp and .h files) and outputs (such as .obj, .exe, and .dll files) to the eMake root automatically.

  This checkbox applies only to C++ projects. If you have a C# project or a project with inputs and outputs not in the solution or project locations, you must add their locations to the eMake root manually.

  This checkbox does not apply to third-party tools, because they cannot be virtualized. This checkbox does not apply to project locations and each location for the solution(s), because they are always added automatically.
Cluster Solution Settings
The following screenshot illustrates the Cluster subcategory.

- **Build Label**—Specifies the build label (--emake-build-label).
- **Build Class**—Specifies the build class (--emake-class).
- **Resource**—Specifies the build resource (--emake-resource).
- **Virtualize Toolchain**—Determines whether to virtualize the Visual Studio toolchain. This checkbox is checked by default.
- **Use 64-bit eMake**—Determines whether to use the 64-bit version of eMake. This checkbox is unchecked by default.
- **Use Local Agents**—Determines whether to use local agents (--emake-localagents). This checkbox is checked by default.

History Solution Settings
The following screenshot illustrates the History subcategory.
• **History File**—Specifies the history file to use (\(--\text{emake-historyfile}\)). The default is eMake.data.

• **History**—Specifies the eMake history option (\(--\text{emake-history}\)). Available values: Create, Merge, or Read.

**Performance Solution Settings**

The following screenshot illustrates the **Performance** subcategory.
- **Maximum PDB Files**—Sets the maximum number of PDB files used when splitting (sets ECADDIN_MAX_PDB_FILES). The default is 16. If you have fewer than 16 agents, you can decrease this value to be equal to or less than the number of agents. This setting has no effect if you enable **Set Debug Information Format to C7 Compatible**, which adds debugging information to the object files.

- **Use Order-Only Prerequisites**—Determines whether to use order-only prerequisites (sets ECADDIN_USE_ORDER_ONLY_PREREQS=true if enabled). Using order-only prerequisites can improve first-time build speed.

- **Always Rescan Solution**—Determines whether to always recreate temporary makefiles even if the solution has not changed.

- **Enable Incremental Link**—Enables or disables incremental linking (sets ECADDIN_ENABLE_INCREMENTAL_LINK=true if enabled).

- **Remove Dependencies**—Determines whether to remove dependencies and references (sets ECADDIN_REMOVE_DEPENDENCIES=true if enabled). Removing dependencies prevents Visual Studio from building dependent projects.

- **Set Debug Information Format to C7 Compatible**—Determines whether to force compiler option /Z7 (sets ECADDIN_FORCE_27). Note that enabling this setting typically creates larger executable files. This setting adds debugging information to the object files and thus overrides **Maximum PDB Files**.
- **Up To Date Check**—Determines whether to check if anything requires building (sets ECADDIN_UP_TO_DATE_CHECK=true if enabled).

- **Run Local Link**—Links specified projects locally using #pragma runlocal (sets ECADDIN_RUN_LOCAL_LINK). Use the projects button to select projects.

- **Coarse Grain Parallelization**—Converts the solution to NMAKE more quickly by parallelizing down to the project level only. It does not require Visual Studio to be installed. Using this option is equivalent to using the ecedeenv /quick option.

- **Local Clean**—Runs clean locally rather than on the cluster. This makes the clean faster and avoids conflicts in a rebuild.

### Annotation Solution Settings

The following screenshot illustrates the **Annotation** subcategory.

- **Annotation Detail**—Specifies the level of annotation detail (--emake-annodetail) from the following selections:
  - **Basic**—Collects information about every command run by the build. Detailed information about each “job” in the build is recorded, including command arguments, output, exit code, timing, and source location. In addition, the build structure is represented as a tree where each recursive make level is represented in the XML output. This checkbox is checked by default.
- **Environment**—Adds information about environment variable modifications.
- **File**—Adds information about files read or written by each job.
- **History**—Adds information about missing serializations discovered by eMake. This includes information about which file caused two jobs to become serialized by the eMake history mechanism.
- **Lookup**—Adds information about files that were looked up by each job.
  
  **Note:** This mode can cause the annotation file to become quite large.
- **Registry**—Adds information about registry operations.
- **Waiting**—Adds information about the complete dependency graph for the build.
- **Annotation File**—Specifies the annotation file (--emake-annofile). Required if annotation detail is set. Use the folder button to select a file.
- **Annotation Upload**—Determines whether to upload the annotation file to the Cluster Manager (--emake-annoupload).

  **Note:** If your local eMake version is 8.1 or newer, and if you select no Annotation Detail checkboxes, the converter sets the --emake-annodetail eMake option to none. In this case, if the version of eMake is older than 8.1 on the agent machines, the following error appears at build time:

```
Starting build: <build number>
ERROR EC1007: Unknown annotation detail token: "none"
Valid tokens are: 'basic', 'env', 'file', 'history', 'lookup', 'md5', 'registry', 'waiting'
```

To avoid this error, you must upgrade the agents to Accelerator 8.1 or newer or check at least one Annotation Detail checkbox.

**ElectricInsight Solution Settings**

This category contains settings for using ElectricInsight from within Visual Studio to monitor build progress. Build monitoring is disabled for non-accelerated builds. This feature requires ElectricInsight version 5.2 or newer.
- **Monitor Build**—Launches ElectricInsight when a build starts. This setting is enabled by default.

- **Host**—Host name or IP address of the ElectricInsight machine where the build will be monitored (hostname in `--emake-monitor=<hostname_or_IP_address>:<port>`). If this is left blank, the current host (the local host) is used.

- **Port**—Port for ElectricInsight monitoring (<IP_address in `--emake-monitor=<hostname_or_IP_address>:<port>`). If this is left blank, the port is selected automatically (to prevent conflicts among `devenv` instances when multiple instances of Visual Studio or ElectricInsight are running). An automatically-selected port number is 2710 + the process ID of the executing `devenv` process.
• **Integrate into IDE**—Docks or undocks ElectricInsight. When this setting is checked, ElectricInsight appears in a Visual Studio tool window rather than its standard user interface outside of Visual Studio. When ElectricInsight is docked, the file menu, toolbar, summary pane, and file name are hidden:

![ElectricInsight docked](image)

### Options Solution Settings

This category contains most frequently used optional settings.
- **Do Not Parse Projects**—Determines whether to prevent the VS Converter from breaking up C++ projects (sets `ECADDIN_DONT_PARSE_PROJECTS=true` if enabled).

- **Run Deployment Locally**—Determines whether to run deployment projects locally using `#pragma runlocal` (sets `ECADDIN_RUN_DEPLOYMENTPROJECTS_LOCALLY=true` if enabled).

- **Continue On Error**—Determines whether to ignore errors that occur during the build (adds `/I` to the call to eMake).

- **Keep Going**—Determines whether to keep going when an error occurs during the build (adds `/k` to the call to eMake).

- **Use Devenv for All Projects**—Determines whether to run all projects using devenv, not MSBuild (sets `ECADDIN_USE_DEVENV=true` if enabled).

- **Use Devenv for Unparsed Projects**—Determines whether to use devenv for unparsed projects (sets `ECADDIN_USE_MSBUILD=true`).

- **Use Devenv for Specified Projects**—Run specified projects using devenv, not MSBuild (sets `ECADDIN_USE_DEVENV_FOR_PROJECTS`). You can either type in the project names (separated by semicolons and without quotes or white spaces) or click the corresponding button to browse for projects.
- **Serialize All Projects**—Determines whether to serialize all projects using `#serialize` (sets `ECADDIN_SERIALIZE=true` if enabled).

- **Do Not Parse Specific Projects**—Prevents the VS Converter from breaking up specified C++ projects (sets `ECADDIN_DONT_PARSE_PROJECT`). You can either type in the project names (separated by semicolons and without quotes or white spaces) or click the corresponding button to browse for projects.

  This variable is useful for deploying the converter. If, for any reason, the converter cannot build some of your projects, this variable lets you work around the problem.

- **Run Local Project**—Runs specified projects locally using `#pragma runlocal` (sets `ECADDIN_RUN_LOCAL_PROJECT`). You can either type in the project names (separated by semicolons and without quotes or white spaces) or click the corresponding button to browse for projects.

  Use this variable if your build uses a local resource (for example, a resource only on the eMake host such as a database). You do not need to set this variable if your project build includes web deployment; this is handled by the converter. Each project name must be the unique Visual Studio identifier for the project (for example, `solution1/project1.vcproj`).

- **Expand Linker Objects**—Determines whether to expand linker objects to full path names (sets `ECADDIN_EXPAND_LINKER_OBJECTS=true` if enabled).

- **Use Solution In MsBuild Projects**—Modifies the call to MSBuild to build a project within the solution context (sets `ECADDIN_BUILD_PROJECTS_IN_SOLUTION_CONTEXT=true` if enabled). This option overrides the **Use Solution For Specified MsBuild Projects** option. This option is needed for unparsed projects (such as C# projects or unparsed C++ projects).

- **Use Solution For Specified MsBuild Projects**—Modifies the call to MSBuild to build specific projects within the solution context (sets `ECADDIN_BUILD_SPECIFIC_PROJECTS_IN_SOLUTION_CONTEXT` accordingly). This option is needed for unparsed projects (such as C# projects or unparsed C++ projects). You can either type in the project names (separated by semicolons and without quotes or white spaces) or click the corresponding button to browse for projects.

**Debug Solution Settings**

This category contains debug options for the **Debug Solution Settings on page 6-18** and **eMake Solution Settings on page 6-21**.
Converter Solution Settings

- **Enable Debug Log**—Determines whether to enable debug logging (sets ECADDIN_DEBUG=true if enabled).

- **Debug Log Name**—Specifies the name of the debug log (sets ECADDIN_DEBUG_LOG_FILENAME). The default location is %TMP%/ecdebug<unique>.log (where %TMP% is usually C:/Users/<username>/AppData/Local/Temp). Use the folder button to select a log file.

- **Do Not Delete Temp Makefiles**—Determines whether to delete temporary makefiles when the build completes (sets ECADDIN_DONT_RM_TMP_MAKEFILES=true if enabled).

- **Do Not Use Unique Names**—Determines whether to use unique names for temporary files (sets ECADDIN_DONT_USE_UNIQUE=true if enabled).

- **Enable ECBreakpoint**—Determines whether to invoke ecbreakpoint in failed jobs.

- **Enable ECBreakpoint for Specific Projects**—Invokes ecbreakpoint for specified projects. Use the folder button to select projects and delimit projects with a semicolon.

**Using Macros in the Solution Settings String-Based Fields**

In any string-based field (such as the path name you enter into the **Debug Log Name** field) in the Electric Cloud solution settings, you can use a custom build command instead of a hardcoded string. For example, you can create a command that generates separate debug logs if you are running separate builds where each build has a different configuration.
Following is an example of a dialog box for entering macros:

![Debug Log Name dialog box]

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>Debug</td>
</tr>
<tr>
<td>ConfigurationName</td>
<td>Debug</td>
</tr>
<tr>
<td>DevEnvDir</td>
<td>C:\Program Files (x86)\Microsoft Visual Studio 10.0\Common7\IDE</td>
</tr>
<tr>
<td>FrameworkDir</td>
<td>C:\Windows\Microsoft.NET\Framework\</td>
</tr>
<tr>
<td>FrameworkSDKDir</td>
<td>C:\Program Files (x86)\Microsoft SDKs\Windows\v7.0A\</td>
</tr>
<tr>
<td>FrameworkVersion</td>
<td>v4.0</td>
</tr>
<tr>
<td>IntDir</td>
<td>$(Configuration)\</td>
</tr>
<tr>
<td><strong>OutDir</strong></td>
<td>$(SolutionDir)$(Configuration)\</td>
</tr>
<tr>
<td>Platform</td>
<td>Mixed Platforms</td>
</tr>
<tr>
<td>PlatformName</td>
<td>Win32</td>
</tr>
<tr>
<td>ProjectName</td>
<td>Win32 App</td>
</tr>
</tbody>
</table>

To edit a set of macros for a field, click in the field, then click the **Macros** button to invoke the macro editor for that field, then click the **Macros** button to view the list of available macros.
eMake Solution Settings

- **Log Name**—Specifies the name of the debug log (sets --emake-logfile). Use the folder button to select a log file.

- **Debugging Options**—Select the log levels for the eMake debug log file. For details about the eMake debug log file and log levels, see the “Electric Make Debug Log Levels” section in the **Troubleshooting** chapter of the *ElectricAccelerator Electric Make User Guide* at [http://docs.electric-cloud.com/accelerator_doc/AcceleratorIndex.html](http://docs.electric-cloud.com/accelerator_doc/AcceleratorIndex.html).

Advanced Solution Settings

This category contains advanced options.
- **Use Environment**—Determines whether to add `/useenv` to the `devenv` call.

- **Max Cluster Agents**—Specifies the maximum number of agents to use during the build (`--emake-maxagents`).

- **Registry Root**—Specifies the registry root (`--emake-reg-roots`). You can specify multiple roots separated by `;` (a semicolon).

- **Monitor**—Allows the build to be monitored by `ElectricInsight` (`--emake-monitor`).

- **Max Local Agents**—Sets the maximum number of local agents to use (`--emake-localagents`). This field is disabled if eMake version 9.1 or later is installed.

- **Yield Local Agents**—If using more than `n` local agents, then eMake releases the number agents over `n` every `t` seconds so they can be used by another eMake that is looking for local agents (`--emake-yield-localagents=N,T`). Two values are required in this format: `release agents over this number, every this number of seconds`. 
- **Auto Depend**—Enables or disables allowing eMake to determine dependencies automatically. Default is enabled.

  Note that Auto Depend is now enabled by default in ecdevenv when ecdevenv is invoked from the Visual Studio command prompt. (When Auto Depend is disabled in the IDE Add-In GUI, this default is overridden when ecdevenv is called from the GUI.)

  For details about Auto Depend (also called eDepend), see the “Dependency Management” chapter in the *ElectricAccelerator Electric Make User Guide* at [http://docs.electric-cloud.com/accelerator_doc/AcceleratorIndex.html](http://docs.electric-cloud.com/accelerator_doc/AcceleratorIndex.html).

- **Visual Studio Setup File**—Specifies the Visual Studio setup file for command line builds. Default is vsvars32.bat.

- **Exclude Environment**—Specifies a list of environment variables to exclude from eMake (--emake-exclude-env), separated by ‘:’ (a colon).

- **F5 Behavior**—Adjusts the behavior of the F5 key to map it to **Electric Cloud > Debug Project**, prompt whether to map it to **Electric Cloud > Debug Project** when pressed, or map it to **Debug > Start Debugging**. As with **Debug > Start Debugging**, this option uses the Visual Studio debugging solution setting to determine whether to prompt to build, always build, or never build before running the debugger.

  **Debug Project** runs the current project (not the startup project as with **Debug > Start Debugging**). **Electric Cloud > Debug Project** is unavailable if zero projects or more than one project is selected.

  Note that you must always use the Visual Studio **Debug** menu to manage the debugging session.

**Command Line Solution Settings**

This category lets you add additional options not explicitly specified elsewhere.
• **Additional Options**—Specifies a list of converter options in this format: `<Name=Value>`. These are the same options specified on Setting VS Converter Environment Variables on page 9-1.

• **Environmental Variables**—Specifies a list of environment variables in this format: `<variable>=<value>`, separated by a carriage return. Do not use `set`.

• **EMake Options**—Specifies a list of eMake options in this format: `--emake<option>=<value>`, separated by a carriage return.

  For Accelerator 9.1 and later versions, you cannot simultaneously use local agents and a cluster manager. This means that using the `--emake-localagents` eMake option and the `--emake-cm` eMake option produces the following error: ERROR EC1323: `--emake-cm` and `--emake-localagents` cannot both be enabled.

• **Command Line**—A non-editable field that shows the ecdevenv command that is executed by the converter. VS Converter options are stored in the `/options` file.

**Help Menu**

This dialog box shows the help resources:
The Community Forum (https://ask.electric-cloud.com/) is where you can find solutions to common problems, or ask a question. Go to http://docs.electric-cloud.com/ to find documentation for all Electric Cloud products.

About

This dialog box shows version information about the currently installed IDE add-in or package, the eMake version and the ElectricInsight version. Refer to these versions where contacting support or asking questions on the community forum.
Chapter 7: Using the ecdevenv Utility

eondevenv.exe is a command-line drop-in replacement for devenv.exe that builds Visual Studio solutions and projects using eMake. Following are the key ecdevenv features:

- Skip generation of NMAKE makefiles
- No makefiles are required
- Visual Studio toolchain virtualization
- Ability to build multiple solutions and projects in one command
- Ability to specify global converter options in an options file
- Forced regeneration of makefiles if required
- Ability to generate makefiles without running eMake

The pre-4.0 behavior of ecdevenv is still supported in versions 4.0 and later.

About ecdevenv

No Makefiles are Required

Without ecdevenv, you must create a makefile to build using eMake:

```
all:
  devenv.exe solution.sln /build Debug
```

Then call this makefile with eMake:

```
emake.exe --emake-cm=<your cm> --emake-emulation=nmake -f makefile
```

With ecdevenv, you can simply use the following command:

```
ecdevenv.exe solution.sln /build Debug --emake-cm=<your cm>
```

econdevenv converts the solution into NMAKE makefiles and runs eMake on them using the eMake parameters specified. Devenv and eMake arguments can be in any order. ecdevenv automatically uses NMAKE emulation.

econdevenv always converts the solution locally, so any differences between the eMake machine and agent machines can be ignored.

**Note:** When invoking ecdevenv, if you build a solution that was created in another version of Visual Studio, a warning appears at the command prompt. For example: Warning: 'MySolution.sln' version (2012) does not match version in use (2005).

Miscellaneous Files that ecdevenv Generates

econdevenv creates several files in the build directory. You do not need to check these files in to your revision control system, unless you want to skip regeneration of NMAKE makefiles.

- *.eccache
"*.eccache" files are created in the same directory as the solution files. One file is created for each invocation of ecdevenv. ecdevenv uses this file to determine whether it needs to regenerate the temporary makefiles. Delete these only if you want to force ecdevenv to regenerate makefiles.

- metrics.sln.Release_Win32.ecmak and metrics.vcxproj.Release_Win32.ecmak

These are temporary makefiles generated by ecdevenv. Do not delete them unless you are regenerating the temporary makefiles.

- metrics_Release_Win32.sln

This is a copy of the original solution used to remove project dependencies. This was generated by ecdevenv (note the configuration name in the file name) Do not delete it unless you are regenerating the temporary makefiles.

- metrics.sln, metrics.vcxproj, metrics.vcxproj.filters, metrics.vcxproj.user

These are Visual Studio files. Do not delete them.

- .roots

This contains the list of generated eMake roots. Do not delete it.

You can relocate these files by using the ECADDIN_MAKEFILE_CACHE environment variable. For details, see the Relocating Makefiles Generated by the Converter on page 9-10 section in the Setting VS Converter Environment Variables on page 9-1 chapter.

**Virtualizing the Visual Studio Toolchain**

Use the /virtualize option to virtualize the Visual Studio toolchain. This virtualizes the Visual Studio installation directory, SDK directory, and relevant registry entries. This negates the need to install Visual Studio on the agent machines. Make sure that you have installed the following software before using this option:

- Relevant .NET version that you are using
- Relevant redistributable for your version of Visual Studio

**Building Multiple Solutions and Projects**

ecdevenv can build multiple solutions. To use this capability, create a makefile in the following format and (optionally) specify the projects and project configurations:

```
<BuildSpecification>
  <Solution>
    <Name>Solution1.sln</Name>
    <Platform>Mixed Platforms</Platform>
    <Configuration>Debug</Configuration>
    <Project>
      <Name>Project1\Project1.vbproj</Name>
      <Platform>Any CPU</Platform>
      <Configuration>Debug</Configuration>
    </Project>
  </Solution>
</BuildSpecification>
```
Then pass the name of the file to ecdevenv using `/configuration=<filename>`.

**Note:** If you use the `/configuration` option, you cannot specify a solution, project, or project configuration on the command line.

### Enabling Debugging Output

- Set `ECDEVENV_DEBUG=true` to turn on debugging (output is sent to stdout by default).
- Set `ECDEVENV_DEBUG_LOG=<filename>` to redirect output to a file.

### Using ecdevenv Command Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>/configuration=&lt;file&gt;</code></td>
<td>Specifies the configuration file that allows multiple solutions and projects to be built. See the Building Multiple Solutions and Projects on page 7-2 section above.</td>
</tr>
<tr>
<td><code>/force</code></td>
<td>Forces the regeneration of makefiles.</td>
</tr>
<tr>
<td><code>/generate</code></td>
<td>Generates the NMAKE makefiles without running eMake.</td>
</tr>
<tr>
<td><code>/help</code></td>
<td>Displays a list of ecdevenv options and sample options and configuration files.</td>
</tr>
<tr>
<td><code>/localclean</code></td>
<td>Runs clean locally rather than on the cluster. This makes the clean faster and avoids conflicts in a rebuild.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>/makefile</td>
<td>Specifies an alternative default makefile (rather than ecdevenv.mak).</td>
</tr>
<tr>
<td>/options=&lt;file&gt;</td>
<td>Specifies the converter options. The file uses the format shown in the Setting VS Converter Environment Variables on page 9-1 chapter.</td>
</tr>
<tr>
<td>/quick</td>
<td>Converts the solution to NMAKE more quickly by parallelizing down to the project level only. For details, see the Using Fast Solution Conversion on page 7-5 section below.</td>
</tr>
<tr>
<td>/skip</td>
<td>Never regenerates makefiles. You use this when you have cached makefiles. You must manually regenerate makefiles using /force when required.</td>
</tr>
<tr>
<td>/use64bit</td>
<td>Specifies the 64-bit version of eMake.</td>
</tr>
<tr>
<td>/version</td>
<td>Displays the ecdevenv version number.</td>
</tr>
<tr>
<td>/virtualize</td>
<td>Virtualize the Visual Studio toolchain (off by default). See the Virtualizing the Visual Studio Toolchain on page 7-2 section above.</td>
</tr>
</tbody>
</table>

### Using ecdevenv Environmental Variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ECDEVENV_DEBUG</td>
<td>Turns on debugging to stdout.</td>
</tr>
<tr>
<td>ECDEVENV_DEBUG_LOG</td>
<td>Redirects the debug output to a specified file.</td>
</tr>
<tr>
<td>ECDEVENV_NO_EXPLICIT_DEPS</td>
<td>Does not use project-to-project dependencies.</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>ECDEVENV_RUN_LOCAL</td>
<td>Specifies a list of projects to locally build #pragma runlocal. All project lists are delimited with semicolons. See the converter option ECADDIN_RUN_LOCAL_LINK.</td>
</tr>
<tr>
<td>ECDEVENV_SKIP_CHECKS</td>
<td>Skips checking for devenv.com in the PATH environment variable.</td>
</tr>
<tr>
<td>ECDEVENV_SKIP_DUPLICATE_PROJECTS</td>
<td>Skips projects if they have been previously built in a different solution.</td>
</tr>
<tr>
<td>ECDEVENV_USE_SOLUTION_CONTEXT</td>
<td>Builds all projects in the solution context. See the Debugging a Failed Build on page 13-1 section.</td>
</tr>
<tr>
<td>ECDEVENV_USE_SOLUTION_CONTEXT_FOR_PROJECTS</td>
<td>Specifies a list of projects to build in the solution context. All project lists are delimited with semicolons. See the Debugging a Failed Build on page 13-1 section.</td>
</tr>
</tbody>
</table>

### Using Fast Solution Conversion

Use `/quick` for fast solution conversion. This option converts the solution to NMAKE more quickly by parallelizing down to the project level only. The option is best suited to solutions containing no C++ projects.

When using the `/quick` option, you must also specify the full platform and configuration. For example, `ecdevenv solution.sln /build "Release|Win32" /quick`.

The option is available only with Visual Studio 2005 and newer versions. If you try to use the option when building a solution in Visual Studio 2002 or Visual Studio 2003, the following error message appears: Error: /quick can only be used with VS2005 and higher.

**Note:** You can also enable fast solution conversion in the IDE converter by checking the Coarse Grain Parallelization checkbox in the General > Performance tab of the Electric Cloud Solution Settings dialog box.

Visual Studio does not need to be installed for you to use fast solution conversion. However, MSBuild must be installed.
Supporting Multi-Byte Characters

When building solutions that have multi-byte characters in their pathnames, set the following environmental variables:

- ECADDIN_USE_INLINE_FILES=false
- EMAKE_MAKEFILE_CODEPAGE=65001
Chapter 8: Building VS from the Command Line

ElectricAccelerator can build Visual Studio solutions in two different modes:

- Use ecdevenv as a drop-in replacement for your command-line build (recommended)
- Create a makefile containing the devenv calls

Using ecdevenv

If you choose to use ecdevenv, replace:

```
  devenv.com Solution.sln /build Debug
```

with:

```
  ecdevenv Solution.sln /build Debug --emake-cm=<yourcm> /virtualize
```

ecdevenv does the following:

1. Converts Solution.sln to NMAKE format.
2. Calls eMake on the generated files.

The /virtualize flag virtualizes the Visual Studio toolchain, negating the need to install Visual Studio on the agents. You must, however, ensure the relevant versions of .NET and redistributables are installed.

```
devenv must be in the PATH environment variable before executing ecdevenv.
```

Creating a Makefile

Before you can use Accelerator to build your Visual Studio project, make sure you have already installed and run Visual Studio on each agent host for each user (all ECloudInternalUsers).

```
Note: Virtualization of the toolchain is not possible when using this method.
```

If you currently invoke Visual Studio from inside a makefile, you are ready. If you invoke Visual Studio directly from the command line or through a batch file, you must create a makefile for eMake to run. For example:

```
all:
  devenv /build Release foo.sln

-- or --

all:
  devenv /build Release foo.sln /project bar.vcproj
```

The makefile must invoke devenv with the options you currently use. Ensure the correct version of devenv is in your path:

```
devenv /?
```
and ensure that the usual Visual Studio environment variables are set.

**Important:** For Visual Studio 2015 and later, you must add "/vsp" to the command line. (When building from the IDE or from ecdevenv.com, this is added automatically.)

For example:

```
all:

devenv /build Release foo.sln /vsp
```

**Setting the Path for 64-Bit or Xbox Builds**

To run 64-bit or Xbox builds, you must set the path manually.
Chapter 9: Setting VS Converter Environment Variables

Setting the Converter Variables

You can control the way the VS Converter works by setting these environment variables on the eMake machine. Alternatively, you can set the variables in a configuration file and set ECADDIN_CONFIGURATION_FILE to its full or relative pathname.

```
all:
    set ECADDIN_CONFIGURATION_FILE=addin.cfg
deenv.com Solution.sln /build Debug
```

Sample addin.cfg:

```
<SolutionSettings>
    <DisableAddin>false</DisableAddin>
    <DoNotParseProjects>false</DoNotParseProjects>
    <ECBreakpoint>false</ECBreakpoint>
    <DoNotParseSpecificProjects/>
    <ECBreakpointProjects/>
    <RunLocalLink/>
    <UseDevenvForProject/>
    <EnableDebugLog>false</EnableDebugLog>
    <DebugLogName>ecdebug.log</DebugLogName>
    <MaxPDBFiles>16</MaxPDBFiles>
    <UseOrderOnlyPrereqs>true</UseOrderOnlyPrereqs>
    <EnableIncrementalLink>false</EnableIncrementalLink>
    <RemoveDependencies>true</RemoveDependencies>
    <ForceZ7>true</ForceZ7>
    <UpToDateCheck>false</UpToDateCheck>
    <DoNotDeleteTempMakefiles>false</DoNotDeleteTempMakefiles>
    <DoNotUseUniqueNames>false</DoNotUseUniqueNames>
    <ExpandLinkerObjects>false</ExpandLinkerObjects>
    <RunDeploymentLocally>false</RunDeploymentLocally>
    <RunLocalProject/>
    <SerializeAllProjects>false</SerializeAllProjects>
    <UseDevenv>false</UseDevenv>
    <UseMSBuild>true</UseMSBuild>
</SolutionSettings>
```

All environment variables override variables in the configuration file, so you can set them outside of the configuration file as needed. The EMAKE configuration file (in $(InstallDir)\i686\win32\conf\emake.conf) may also override these settings.

**Note:** Environment variables that take Boolean values can accept "0", "no", "false", "off", "1", "yes", "true", or "on". Case is not significant.
<table>
<thead>
<tr>
<th>Environment Variable and Configuration File Variable</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>- AddEmakeRootsAutomatically</td>
<td>Adds the locations of all inputs (such as .cpp and .h files) and outputs (such as .obj, .exe, and .dll files) to the eMake root automatically. This variable applies only to C++ projects. For a C# project or a project with inputs and outputs not in the solution or project locations, you must add their locations to the eMake root manually. This variable does not apply to third-party tools, because they cannot be virtualized. It also does not apply to project locations and each location for the solution(s), because they are always added automatically.</td>
<td>False (converter) True (ecdevenv and IDE)</td>
</tr>
<tr>
<td>ECADDIN_BUILD_ORDER BuildOrder</td>
<td>Specifies projects' build order. Use only if Accelerator is not building projects in the correct order.</td>
<td>-</td>
</tr>
<tr>
<td>ECADDIN_BUILD_PROJECTS_IN_SOLUTION_CONTEXT BuildProjectsInSolutionContext</td>
<td>Modifies the call to MSBuild to build a project within the solution context. This overrides the ECADDIN_BUILD_SPECIFIC_PROJECTS_IN_SOLUTION_CONTEXT variable and the BuildSpecificProjectsInSolutionContext configuration file variable. This option is needed for unparsed projects (such as C# projects or unparsed C++ projects).</td>
<td>False</td>
</tr>
<tr>
<td>Environment Variable and Configuration File Variable</td>
<td>Description</td>
<td>Default</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>ECADDIN_BUILD_SPECIFIC_PROJECTS_IN_SOLUTION_CONTEXT</td>
<td>Allows a list of projects to be built in the solution context in MSBuild. Supply a list of projects (separated by a semicolon but no spaces). This option is needed for specific unparsed projects (such as C# projects or unparsed C++ projects).</td>
<td></td>
</tr>
<tr>
<td>ECADDIN_CONFIGURATION_FILE</td>
<td>Sets the filename of the configuration file. Environment variables override the settings in this file.</td>
<td></td>
</tr>
<tr>
<td>ECADDIN_CREATE_MISSING_DEPENDENCIES</td>
<td>Creates missing dependencies to avoid missing dependency warnings.</td>
<td>False</td>
</tr>
<tr>
<td>ECADDIN_DEBUG</td>
<td>Setting this variable to any value causes debug log files to remain in %TMP%\ecdebug&lt;ID&gt;.log on the agent host. These files are used for troubleshooting by Electric Cloud engineers. Normally, you do not need to set this value.</td>
<td>False</td>
</tr>
<tr>
<td>ECADDIN_DEBUG_LOG_FILENAME</td>
<td>Specifies the debug log name. Requires ECADDIN_DEBUG. Use '$1' in the file specification to insert a unique ID. For example, C:\Users\Bill\ecdebug_$1.log. Use a file location outside of eMake root. The log file is stored on the agent.</td>
<td></td>
</tr>
<tr>
<td>ECADDIN_DISABLE_MINIMAL_REBUILDS</td>
<td>Disables minimal rebuilds.</td>
<td>False</td>
</tr>
<tr>
<td>ECADDIN_DISALLOW_BSC</td>
<td>Does not generate browse information files.</td>
<td>False</td>
</tr>
<tr>
<td>Environment Variable and Configuration File Variable</td>
<td>Description</td>
<td>Default</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>ECADDIN_DISALLOW_PCH DisallowPCH</td>
<td>Does not generate/use precompiled header files (implied by ECADDIN_MAX_PDB_FILES)</td>
<td>False</td>
</tr>
<tr>
<td>ECADDIN_DISALLOW_PDB DisallowPDB</td>
<td>Does not generate PDB files.</td>
<td>False</td>
</tr>
<tr>
<td>ECADDIN_DISALLOW_SBR DisallowSBR</td>
<td>Does not generate browse information files from sources.</td>
<td>False</td>
</tr>
<tr>
<td>ECADDIN_DONT_ADD_PCH_LOCATION DoNotAddPCHLocation</td>
<td>Prevents the converter from adding the location of the PCH file in all cases. This variable is relevant only if ECADDIN_MAX_PDB_FILES or ECADDIN_DISALLOW_PCH is switched on.</td>
<td>False</td>
</tr>
<tr>
<td>ECADDIN_DONT_ALLOW_PCH_AND_PDB DoNotAllowPCHAndPDB</td>
<td>Switches off PDB and PCH generation.</td>
<td>False</td>
</tr>
<tr>
<td>ECADDIN_DONT_PARSE_PROJECT DoNotParseSpecificProjects</td>
<td>Prevents the VS Converter from breaking up specified C++ projects. This variable takes a list of project names separated by semicolons and without white spaces. This variable is useful for deploying the converter. If, for any reason, the converter cannot build some of your projects, this variable lets you work around the problem. When using this variable, you might experience an the warning MSB4098. You can ignore this warning, because any project references are now converted into additional dependencies. MSBuild, however, does not provide a mechanism to turn off this warning.</td>
<td>–</td>
</tr>
<tr>
<td>Environment Variable and Configuration File Variable</td>
<td>Description</td>
<td>Default</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>ECADDIN_DONT_PARSE_PROJECTS DoNotParseProjects</td>
<td>This variable takes any non-blank value and its behavior is similar to ECADDIN_SERIALIZE. It calls devenv on each project (the converter does not convert each project into individual compile/link steps).</td>
<td>-</td>
</tr>
<tr>
<td>ECADDIN_DONT_RM_TMP_MAKEFILES DoNotDeleteTempMakefiles</td>
<td>Retains makefiles created during the build but normally deleted when the build finishes. This environment variable can have any value; it just needs to be set.</td>
<td>False</td>
</tr>
<tr>
<td>ECADDIN_DONT_RUN DoNotRun</td>
<td>TEST only. Convert makefiles without running eMake.</td>
<td>False</td>
</tr>
<tr>
<td>ECADDIN_DONT_USE DisableAddin</td>
<td>Disables the converter. This environment variable can have any value, it just needs to be set. Also, you can disable the converter on each host by using the Visual Studio Converter Manager (on the Tools menu).</td>
<td>False</td>
</tr>
<tr>
<td>Note: This is a lightweight uninstall program that disables one individual machine at a time.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ECADDIN_DONT_USE_UNIQUE DoNotUseUniqueNames</td>
<td>Does not use unique names for temporary makefiles. Use with ECADDIN_DONT_RM_TMP_MAKEFILES.</td>
<td>False</td>
</tr>
<tr>
<td>ECADDIN_ECBREAKPOINT ECBreakpoint</td>
<td>Determines whether to invoke ecbreakpoint on failed jobs.</td>
<td>False</td>
</tr>
<tr>
<td>ECADDIN_ECBREAKPOINT_PROJECTS ECBreakpointProjects</td>
<td>Determines whether to invoke ecbreakpoint for specified projects. Use a semicolon to delimit projects.</td>
<td>-</td>
</tr>
<tr>
<td>Environment Variable and Configuration File Variable</td>
<td>Description</td>
<td>Default</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>ECADDIN_ENABLE_INCREMENTAL_LINK EnableIncrementalLink</td>
<td>Inserts a call to ectouch.exe. See Tuning Performance on page 10-1.</td>
<td>True</td>
</tr>
<tr>
<td>ECADDIN_EXPAND_LINKER_OBJECTS ExpandLinkerObjects</td>
<td>Expands linker objects to one line per object. Prevents errors when link line length is exceeded.</td>
<td>False</td>
</tr>
<tr>
<td>ECADDIN_FORCE_27 ForceZ7</td>
<td>Enables /Z7 compiler options for all C++ files. Note that enabling this setting typically creates larger executable or library files. Enabling this setting adds debugging information to the object files and therefore overrides ECADDIN_MAX_PDB_FILES.</td>
<td>True</td>
</tr>
<tr>
<td>ECADDIN_INCLUDE_CMAKELISTS IncludeCMakeLists</td>
<td>Excludes any source file with the name CMakeLists.txt. Set this variable to True to execute the file.</td>
<td>False</td>
</tr>
<tr>
<td>ECADDIN_INJECT_PCH_REFERENCE InjectPCHReference</td>
<td>Adds /Y1&lt;projectname&gt; to the PCH creator (/Yc). Set it to false only if linker tools error LNK2005 (multiply-defined symbol error) appears.</td>
<td>True</td>
</tr>
<tr>
<td>ECADDIN_LINK_PARAMETERS LinkParameters</td>
<td>Adds options to the linker command. You can specify one or more options separated by spaces. For example, ECADDIN_LINK_PARAMETERS=/OPT:REF or LinkParameters=/INCREMENTAL /NOLOGO /DEBUG /PDB:a.pdb.</td>
<td>-</td>
</tr>
<tr>
<td>ECADDIN_MAKEFILE_CACHE MakefileCache</td>
<td>Path to an alternate location for the cached (temporary) makefiles that are generated by the converter. For details, see the Relocating Makefiles Generated by the Converter on page 9-10 section below.</td>
<td>-</td>
</tr>
<tr>
<td>Environment Variable and Configuration File Variable</td>
<td>Description</td>
<td>Default</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>ECADDIN_MAX_PDB_FILES MaxPDBFiles</td>
<td>Specifies the maximum number of PDB files to produce. This setting has no effect if you set ECADDIN_FORCE_Z7=true, which adds debugging information to the object files. For details, see Optimizing Parallelization Using PDB Splitting on page 10-3.</td>
<td>16</td>
</tr>
<tr>
<td>ECADDIN_MSBUILD_DIR MSBuildDir</td>
<td>Path to the location of msbuild.exe if different from the default.</td>
<td>–</td>
</tr>
<tr>
<td>ECADDIN_MSBUILD_PARAMETERS MSBuildParameters</td>
<td>Adds extra parameters to msbuild command line.</td>
<td>–</td>
</tr>
<tr>
<td>ECADDIN_NOLINK NoLink</td>
<td>Performs all build steps except linking and post build steps. When this variable is enabled, Visual Studio displays the following message at build time: Warning: Not linking because ECADDIN_NOLINK is set.”</td>
<td>False</td>
</tr>
<tr>
<td>ECADDIN_PARSE_BUILD_CUSTOMIZATIONS ParseBuildCustomizations</td>
<td>Recognizes Visual Studio build customizations. If you encounter issues with a project when using this feature, you can disable it for all projects containing Build Customizations by setting it to FALSE or by disabling parsing for only that project by setting ECADDIN_DONT_PARSE_PROJECT or DoNotParseSpecificProjects to TRUE.</td>
<td>True</td>
</tr>
<tr>
<td>Environment Variable and Configuration File Variable</td>
<td>Description</td>
<td>Default</td>
</tr>
<tr>
<td>-------------------------------------------------------</td>
<td>-------------</td>
<td>---------</td>
</tr>
</tbody>
</table>
| **ECADDIN_NORECURSE**  
  **NoRecurse** | Builds only the specified project configurations while ignoring dependent projects in those configurations. When used in conjunction with /Clean, this cleans only the specified configurations. When used in conjunction with /Rebuild, this rebuilds only the specified configurations. | False |
| **ECADDIN_REMOVE_DEPENDENCIES**  
  **RemoveDependencies** | Removes project-to-project dependencies to improve parallelization. | False |
| **ECADDIN_RUN_DEPLOYMENT_PROJECTS_LOCALLY**  
  **RunDeploymentLocally** | Runs deployment projects locally using #pragma runlocal. | False |
| **ECADDIN_RUN_LOCAL_LINK**  
  **RunLocalLink** | A list of projects where the linker will be run locally (using #pragma runlocal). | – |
| **ECADDIN_RUN_LOCAL_PROJECT**  
  **RunLocalProject** | Use this variable if your build uses a local resource (for example, a resource only on the eMake host (for example, a database). You do not need to set this variable if your project build includes web deployment; this is handled by the converter. The value of this variable is a list of project names separated by semicolons. Each project name must be the unique Visual Studio identifier for the project (for example, solution1/project1.vcproj). Do not add quotation marks or white spaces. | – |
<table>
<thead>
<tr>
<th>Environment Variable and Configuration File Variable</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>EADDIN_SERIALIZE SerializeAllProjects</td>
<td>Causes each project to be built serially. It inserts ‘#pragma allserial’ into each makefile. This variable is equivalent to setting ECADDIN_DONT_PARSE_PROJECTS.</td>
<td>False</td>
</tr>
<tr>
<td>ECADDIN_UP_TO_DATE_CHECK UpToDatecheck</td>
<td>Pre-parses the projects to determine whether there is anything to build. Prevents unnecessary rebuilding of static build steps.</td>
<td>True</td>
</tr>
<tr>
<td>ECADDIN_USE_DEVENV UseDevenv</td>
<td>Uses devenv (rather than msbuild) for all unparsed projects.</td>
<td>False</td>
</tr>
<tr>
<td>ECADDIN_USE_DEVENV_FOR_PROJECT UseDevenvForProject</td>
<td>Uses devenv (rather than msbuild) to build specific projects. Supply a list of projects (separated by a semicolon) to be built with devenv.</td>
<td>–</td>
</tr>
<tr>
<td>ECADDIN_USE_LEGACY_CODE UseLegacyCode</td>
<td>Use this variable to workaround a Visual Studio bug where AdditionalLibraryDirectories does not give the correct value.</td>
<td>False</td>
</tr>
<tr>
<td>ECADDIN_USE_MSBUILD UseMSBuild</td>
<td>Uses msbuild internally for projects that the converter cannot parse.</td>
<td>True</td>
</tr>
<tr>
<td>ECADDIN_USE_MSBUILD_FOR_LINK UseMSBuildForLink</td>
<td>(Visual Studio 2010 and newer versions) Uses msbuild internally for linking. These variables are a workaround for an issue in which VCManifestTool is not supported in Visual Studio 2015 and newer versions and might not be supported in Visual Studio 2010–2013.</td>
<td>True (VS 2015+) False (VS 2010–2013)</td>
</tr>
<tr>
<td>Environment Variable and Configuration File Variable</td>
<td>Description</td>
<td>Default</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>ECADDIN_USE_ORDERONLY_PREREQS UseOrderOnlyPreReqs</td>
<td>Uses order-only prerequisites (available in Accelerator v7.0 and later). This allows for quicker first time builds.</td>
<td>True</td>
</tr>
<tr>
<td>ECADDIN_USE_RELATIVE_PATHS UseRelativePaths</td>
<td>Uses relative paths in the makefile to reduce line lengths and to allow the build location to be changed without regenerating makefiles.</td>
<td>–</td>
</tr>
<tr>
<td>ECADDIN_USE_WCE_MACROS UseWCEMacros</td>
<td>Loads platform macros.</td>
<td>False</td>
</tr>
<tr>
<td>ECADDIN_XBOX_INSTALL_DIR XBoxInstallDir</td>
<td>Path to the location of Xbox SDK if different from the default.</td>
<td>–</td>
</tr>
<tr>
<td>ECADDIN_XBOX_VERSION XBoxVersion</td>
<td>Xbox SDK version if different from the default.</td>
<td>–</td>
</tr>
</tbody>
</table>

### Relocating Makefiles Generated by the Converter

Generated (temporary) makefiles include .ecmak files, solutions and projects, RC files, and up-to-date check files. By default, these files are in the same location as their corresponding solution or project. For example:

- `C:\Test\solution_001\solution_001.sln` generates `C:\Test\solution_001\solution_001.sln.ecmak`
- `C:\Test\solution_001\project1\project1.vcxproj` generates `C:\Test\solution_001\project1\project1.vcxproj.ecmak`

You can specify a path to an alternate location for these files by setting the `ECADDIN_MAKEFILE_CACHE` environment variable. For example, if you enter `set ECADDIN_MAKEFILE_CACHE=C:\temp`, then

- `C:\Test\solution_001\solution_001.sln` generates `C:\temp\solution_001.sln.ecmak`
- `C:\Test\solution_001\project1\project1.vcxproj` generates
  - `C:\temp\project1\project1.vcxproj.ecmak`

(Note that the makefiles are relative to the solution directory.) This variable is useful when you want to keep eMake-generated files out of the source tree or when the source tree is read-only.

**Note:** If you use this environment variable, keep in mind that the paths for the generated files must not exceed the Windows character limit.
Setting the Environment Variable to Enable Local Solution Builds

You can build a solution locally with eMake but without using remote agents or local agents. You might want to use this function if a distributed incremental build is slow, or if a local Visual Studio incremental build causes unnecessary rebuilding of objects. To make this function visible in the Electric Cloud menu, set the environment variable ECUIADDIN_LOCAL_BUILD=true. For more information about this menu, see the Main Menu and Toolbar on page 6-2 section.

Setting the Environment Variable for ecdevenv Startup Checks

By default, the ecdevenv utility perform several checks (such as the existence and proper version number of the converter) when it starts. To disable the checks, set the environment variable ECDEVENV_SKIP_CHECKS=true.
Chapter 10: Tuning Performance

The converter has several methods for improving performance. To determine which is best for your situation, generate an annotation file and open it in ElectricInsight.

To generate an annotation file, pass `--emake-annodetail=basic,file,lookup,env` to your eMake call. By default, the annotation file is named `emake.xml`.

Available methods:

- Improving Build Time for /Zi + PCH Builds on page 10-1
- Improving Build Time for Solutions with Many Projects on page 10-1
- Improving Final Link Time on page 10-2
- Improving Incremental Build Time on page 10-2
- Improving Incremental Linking Time on page 10-2
- Optimizing Parallelization Using PDB Splitting on page 10-3

Improving Build Time for /Zi + PCH Builds

The default configuration for VC++ projects is /Zi and using PCH. To parallelize this combination, the converter splits PDB and duplicates PCH. However PCH files are usually very large and might negate any improvement parallelization offers.

To improve build time in these circumstances:

1. Set `ECADDIN_FORCE_Z7=true`.
   
   This is the single most effective way to improve build speed. Enabling this setting does not create PDB files and thus overrides `ECADDIN_MAX_PDB_FILES`.

2. Set `ECADDIN_DISALLOW_PCH`.
   
   This turns off PCH but might result in build failures that can be fixed in code only.

3. Reduce `ECADDIN_MAX_PDB_FILES`.
   
   Reducing this setting reduces parallelism but decreases the time spent copying PCH files. (This setting has no effect if you set `ECADDIN_FORCE_Z7=true`, which does not create PDB files.)

Improving Build Time for Solutions with Many Projects

Some very large solutions with few interproject dependencies might benefit from not parsing the project down to the project item level. Follow these steps:

1. Set `ECADDIN_DONT_PARSE_PROJECTS=true`.
2. Clear history.
3. Rebuild.
Although you lose fine-grain parallelism, the reduced overhead might reduce the overall build time.

**Improving Final Link Time**

Many typical solutions have a final link (or lib) that is very large and slow on the cluster. To perform this link locally, set ECADDIN_RUN_LOCAL_LINK=<project>.

**Important:** Running projects locally with #pragma runlocal might cause other issues. When running with #pragma runlocal, only changes in the current working directory are recognized by EFS, so it is not advised if there are subsequent jobs that use files outside of the CWD.

**Improving Incremental Build Time**

By default, the converter does not rebuild prebuild events. Instead, the converter first checks whether there is anything out of date. If not, nothing will be built, including the prebuild event.

To always rebuild prebuild events, set ECADDIN_UP_TO_DATE_CHECK=false. Note that when you set this environment variable to false, if you have a prebuild event that touches files, it could potentially rebuild far more than Visual Studio would.

**Improving Incremental Linking Time**

**Improving Incremental Linking Time with the Converter**

Visual Studio supports incremental linking with the /INCREMENTAL linker option. This does not function in eMake, because eMake updates the time stamp of the exe/dll when it copies it back to the build machine (from the agent) to prevent any problems because of clock skew.

To work around this problem, the converter "touches" the exe after the link with its current time stamp. This explicit modification of the time stamp instructs eMake to preserve the time stamp, which keeps the validity of its incremental status. The converter inserts a call to ectouch.exe, which performs the action stated above. ectouch.exe must be in %PATH%.

To disable this feature with the converter, set ECADDIN_ENABLE_INCREMENTAL_LINK=false.

**Improving Incremental Linking Time without the Converter**

If you are not using the converter, you can still use this feature. You can rename ectouch.exe to eclink.exe and replace occurrences of link.exe with eclink.exe. eclink.exe should be in %PATH%. Alternatively, you can rename link.exe to link_ec.exe and copy eclink.exe to link.exe. (If you want something other than link_ec.exe, set EC ORIGINAL LINK PATH to the location of the “real” link.exe.)
Optimizing Parallelization Using PDB Splitting

Optimizing Parallelization with the Converter

By default, Visual Studio puts all debugging information in a centralized database (PDB) called vc80.pdb (this is Visual Studio version-specific). Because each compilation modifies this file, everything in the project is serialized. A workaround is to group debug information into multiple PDB files. You can accomplish this automatically if you use the converter.

ECADDIN_MAX_PDB_FILES is set to 16 by default. You can change this value to be equal to or less than the number of agents, but you might need to increase or decrease this for optimal efficiency. ECADDIN_MAX_PDB_FILES specifies the maximum number of PDB files produced. Each file is placed into a PDB determined by a hash of its filename. This method ensures that a particular file is always placed in the same PDB. This is necessary to ensure eMake's history file remains valid.

For example, if a project contains 4 files, File1.cpp, File2.cpp, and so on, and they are all serialized on PDB file vc80.pdb. Set ECADDIN_MAX_PDB_FILES=2 will create (at most) 2 PDB files:

File1.cpp --' <ProjectName>_0.pdb
File2.cpp --' <ProjectName>_1.pdb
File3.cpp --' <ProjectName>_0.pdb
File4.cpp --' <ProjectName>_1.pdb

In this example, File1 and File3 will be serialized against each other but will build in parallel from File2 and File4 (which will be serialized against each other).

You can change this variable in the Visual Studio IDE Converter solution settings. Go to the Performance section of the Converter pane.

The history file must be deleted when adding or changing the value of ECADDIN_MAX_PDB_FILES. You can also set --eMake-history=create.

Optimizing Parallelization without the Converter

This technique can be used without using the converter. This distribution contains the application hashstr.exe, which hashes the filename and returns the bucket number. You can use this in your makefile to set the PDB filename (using /fd) in the same manner as above. Precompiled headers must be switched off for this to work.

Usage: hashstr "mystring" [modulus]

Where mystring is the string from which to generate the hash value, and modulus is the number of hash bins you want to use.

You can add this to a pattern rule for builds that suffer from performance degradation due to PDB serialization, with something similar to the following:

%.o: %.c
Troubleshooting

ElectricInsight lets you pinpoint performance problems or conflicts in a parallel build. Until now, there has been little visibility into builds to “see” why a build was slow, why a build broke, or which dependencies were involved. ElectricInsight® (Insight) removes the “black box” around software product builds and provides easy-to-understand performance data.
Chapter 11: Using MSBuild

Building MSBuild Projects in Parallel

ElectricAccelerator cannot parallelize MSBuild project files. If you have multiple MSBuild projects, however, you can create a makefile to build them in parallel.

For example:

```
all: project1 project2
  project1
    msbuild myproject.csproj /t:build
  project2:
    msbuild myproject.csproj /t:build
```

Then run:

```
emake -f makefile --emake-emulation=nmake --emake-cm<your cm>
```

For C++ projects, call devenv (or ecddevenv) to parallelize those projects down to the project item level.

If you use a top-level MSBuild script that builds separate projects, convert that to NMAKE in the format above to achieve parallelization under eMake.

Using MSBuild to Build a Project Directly in Its Solution Context

When set to true, the ECADDIN_USE_SOLUTION_IN_MSBUILD environment variable lets you use MSBuild to build a project directly, but in the context of its solution, by generating an appropriate call to be sent to MSBuild. For example, when you build a C# project named WindowsApplication2 with project configuration Debug|AnyCPU, the generated makefile contains the following call to MSBuild:

```
"msbuild.exe" "WindowsApplication2.csproj" /t:build
/p:Configuration="Debug",Platform="AnyCPU"
```

(Note that MSBuild expects there to be no space between Any and CPU.)

When you set the environment variable to true, the command is changed to build the WindowsApplication2 project in solution configuration Debug|Mixed Platforms:

```
"msbuild.exe" "solution_0012.sln" /t:WindowsApplication2
/p:Configuration="Debug",Platform="Mixed Platforms"
```
Chapter 12: Uninstalling the Visual Studio Integration

An uninstallation removes all VSP components from a machine. This includes the converters and the ecedeenv.exe utility from the prior installation. To uninstall the software, follow the procedures described in the following topics.

Uninstalling the Visual Studio Integration on Windows

The uninstaller removes all Visual Studio Integration components from a machine at the same time.

Using the GUI

1. Go to the Electric Cloud installation folder.
2. Run the uninstaller one of these ways:
   - Enter `uninstall-vsaddin.exe`.
   - Invoke the uninstaller by using the "Add or Remove Programs" or "Programs and Features" utilities in the Windows Control Panel. The following prompt appears:
3. Click **Yes**.

The "Uninstall Complete" dialog box appears when the uninstallation is complete:

![Uninstall Complete Dialog Box](image)

**Using the Command Line**

You can also run the uninstaller in silent mode from the command line.

1. Open a command prompt.
2. Enter `cd <Electric Cloud installation folder>` to go to the Electric Cloud installation folder, where `<Electric Cloud installation folder>` is the installation folder.
3. Enter `uninstall-vsaddin.exe /mode silent`.
Chapter 13: Debugging a Failed Build

Perform the following tasks first when debugging a failed build:

- Double-check that the build works under Visual Studio.
- See the Troubleshooting Problems on page 14-1 chapter or ask.electric-cloud.com.

If the previous tasks do not help you debug your build, do the following steps:

1. Set ECADDIN_DEBUG=true and ECADDIN_DEBUG_LOG_FILENAME=<filename>
2. Rerun the build.

The <filename> will exist on the machine that performed the conversion. When using ecdevenv, this will be the local machine. When running devenv or ecdevenv remotely, the file will exist on the remote machine.
Chapter 14: Troubleshooting Problems

Initializing Visual Studio

If you do not virtualize the toolchain and did not initialize Visual Studio on every agent host for each ECloudInternalUser during installation, you must do the initializations manually. Each Accelerator agent runs as user ECloudInternalUser1, ECloudInternalUser2, and so on.

On each agent host:

1. Log into the user account.
2. Run Visual Studio.
3. Choose Tools > Options and browse to Project and Solutions > Build and Run.
4. Set the maximum number of parallel project builds to 1.
5. Choose Help > Customer Feedback Options.
6. Initialize the Customer Experience Improvement Program to either Yes or No.

If you still encounter issues, go to the Electric Cloud ElectricAccelerator Knowledge Base and search for “Visual Studio.” Also refer to ask.electric-cloud.com for answers to common issues with eMake and the Visual Studio Integration.

Common Issues

Check this list of common issues after you verify that Visual Studio initialized properly:

- Visual Studio is missing the Electric Cloud menu on page 14-2
- Application Data folder could not be created. make: *** [all] on page 14-2
- For VS2005 SP1 builds, the build is not broken up and runs as one large job on page 14-3
- Build terminated with “not making progress” error on page 14-3
- Visual Studio quits immediately at the start of the build on page 14-3
- Error “‘devenv’ not found” is displayed on page 14-3
- Error “Unable to build specified project” or missing file errors on page 14-3
- Error “msbuild not found” on page 14-4
- Missing DLL errors or Visual Studio installation is corrupt on page 14-4
- Error “command line too long” on page 14-4
- The build is slow (not parallelized) and/or each line of the build output is prefixed with 1>, 2>, etc on page 14-4
- Error: '|' not recognized on page 14-4
- When virtualizing the Visual Studio toolchain, regsvr32 fails trying to register a DLL that uses debug CRT DLLs on page 14-5
- Particular projects do not build under eMake on page 14-5
- Electric Cloud menu in Visual Studio is grayed out (disabled) on page 14-5
Using Visual Studio 2010, a project fails at link when using the add-in but succeeds when using Visual Studio alone on page 14-5
Upgrading only cluster agents to Accelerator v7.0 might cause an error on page 14-6

Visual Studio is missing the Electric Cloud menu

Description

The VS IDE Converter is installed, but the Electric Cloud menu is missing and the Tools menu item is corrupted (shows "Electric Cloud").

The converter might throw an exception similar to the following:

3:Error: Adding Build menu item: Could not load file or assembly 'stdole, Version=7.0.3300.0, Culture=neutral, PublicKeyToken=b03f5f7f11d50a3a' or one of its dependencies. The system cannot find the file specified.

Cause

This occurs because the converter requires stdole.dll to be installed and registered.

Solution

1. Close all instances of Visual Studio.
2. Uninstall the converter from Control Panel.
3. Open a command prompt and register the DLL manually (Adjust the path to gacutil.exe accordingly.):

   "%PROGRAM_FILES%\Microsoft SDKs\Windows\v7.0A\Bin\gacutil.exe" -i "%PROGRAM_FILES%\Common Files\Microsoft Shared\MSEnv\PublicAssemblies\stdole.dll"

   Run Visual Studio and check if the Electric Cloud menu is present.
5. Run:

   devenv.exe /ResetSettings

   This resets the menus.
6. Re-install the converter and run Visual Studio.

Application Data folder could not be created. make: *** [all]

Cause

The current user does not have an account on the agent that is running devenv.exe.

Solution

Do one of the following:

- Use one of the solutions described in the "What does it mean when Visual Studio reports "The Application Data folder for Visual Studio could not be created"?" Ask article at

- Use ecdenv locally (so that devenv.exe does not need to run on the agent).

**For VS2005 SP1 builds, the build is not broken up and runs as one large job**

**Cause**
The hotfix for VS2005 SP1 is not installed.

**Solution**

**Build terminated with “not making progress” error**

**Cause**
There are many reasons for this error. It usually occurs when a build has shown a modal dialog box (that is not visible to the build user) and is waiting for input.

**Solution**

**Visual Studio quits immediately at the start of the build**

**Cause**
You are running the wrong version of Visual Studio for your build.

**Solution**
Ensure the environment is setup for the version of Visual Studio you are using.

**Error “devenv’ not found” is displayed**

**Cause**
Visual Studio is not installed on the agent or is not in the same location as the build machine.

**Solution**
Install Visual Studio on the agent or set the PATH environment variable to reflect the installation directory on the agent.

**Error “Unable to build specified project” or missing file errors**

**Cause**
The missing project or files are not in the eMake root.
Solution
Make sure all files are either present on the agent, or in the emake root.

Error “msbuild not found”

Cause
.NET is not installed on the agent.

Solution
Install the relevant version of .NET on all agents.

Missing DLL errors or Visual Studio installation is corrupt

Cause
C++ redistributable is not installed on the agent.

Solution
Install the relevant redistributable for the version of Visual Studio you’re using on the agents.

Error “command line too long”

Cause
The converter has generated a command line that is too long.

Solution
If the error occurs during linking, set ECADDIN_EXPAND_LINKER_OBJECTS=true, otherwise set ECADDIN_USE_RELATIVE_PATHS=true in your environment.

The build is slow (not parallelized) and/or each line of the build output is prefixed with 1>, 2>, etc

Cause
The build is not using the converter. The 1>, 2> is an indication that devenv is being used.

Solution
Check that the VS Converter is installed on the agents or build machine. (Go to Tools > Add In Manager.)
For VS2005 SP1, check if the hotfix is installed (see above).
Check for other third-party converters on the agents. The VS Converter might not be compatible with other build-related converters.

Error: ‘\’ not recognized

Cause
You are using an older Accelerator version (pre 7.0) that doesn’t recognize order-only prerequisites.
Solution

Turn off ECADDIN_USE_ORDER_ONLY_PREREQs.

When virtualizing the Visual Studio toolchain, regsvr32 fails trying to register a DLL that uses debug CRT DLLs

Cause

These SxS DLLs cannot be virtualized and are not part of the Visual Studio redistribution.

Solution

Do one of the following:

- Copy debug DLLs from <VSINSTALLDIR>\VC\redist\Debug_NonRedist to the target directory (the location of the DLL that is being registered)
- Copy Microsoft.VC90.DebugCRT.manifest and msvcr90d.dll from <VSINSTALLDIR>\VC\redist\Debug_NonRedist\x86\Microsoft.VC90.DebugCRT

Particular projects do not build under eMake

Solution

Use ECADDIN_DONT_PARSE_PROJECT to specify the offending projects. Use either the project name or the project path as shown in the solution file.

Electric Cloud menu in Visual Studio is grayed out (disabled)

Cause

This might occur if you install Visual Studio after installing the converter. Visual Studio’s setup routine has not initialized the converter.

Also, the debug log will contain: AddCommandControls failed for Build: The parameter is incorrect. (Exception from HRESULT: 0x80070057 (E_INVALIDARG))

Solution

Open a Visual Studio 2010 or later command prompt as administrator and type:

devenv /setup

Using Visual Studio 2010, a project fails at link when using the add-in but succeeds when using Visual Studio alone

Description

You encounter this error: LINK : fatal error LNK1123: failure during conversion to COFF: file invalid or corrupt

Solution

Upgrade Visual Studio to 2010 SP1.
Upgrading *only cluster agents* to Accelerator v7.0 might cause an error

**Cause**

When upgrading the cluster agents only to Accelerator v7.0, be advised that an older eMake client will run the same version of eMake on the agent (if it is available). This might result in the following error:

NMAKE : fatal error U1073: don't know how to make '|'

**Solution**

Do one of the following:

- Upgrade the local eMake client to 7.0 or later (recommended).
- Set `ECADDIN_USE_ORDER_ONLY_PREREQS=false` in your environment.
Index

A
About 6-25

B
build
  local builds 6-3
  multiple solution and projects 7-2

C
common issues 14-1
Converter Add-In 8-1
  known issues 3-1
  upgrading 4-2

D
debugging 13-1

E
ecedevenv 7-1
ElectricInsight 6-1, 6-3
eMake 6-1
environment variables 9-1

H
help menu 6-24

I
IDE Add-In installation 5-1
initializing Visual Studio 14-1

Insight (ElectricInsight) 6-1, 6-3
installation
  silent 5-1
installing the IDE Add-In 5-1

M
main menu 6-2
makefile creation 8-1
msbuild 11-1

P
performance optimization of Visual Studio 10-1
prerequisites 4-1
problems, common 14-1
settings
  advanced 6-21
  command line 6-23
debug 6-18
options 6-16

S
supported Visual Studio versions 4-1

T
toolbar 6-2
toolchain virtualization 7-2
troubleshooting 14-1

upgrading 4-2

virtualization of the Visual Studio toolchain 7-2

Visual Studio

  performance optimization 10-1
  supported versions 4-1
  Virtualization of the toolchain 7-2